User Interface Guide

Version 6.1
Note

Before using this information and the product it supports, read the general information under "Notices" on page 65.
Contents

About this book ........................................... v
Who should use this book ......................... v
How to use this book .................................. v
    Typographic conventions ....................... v
    Accessibility .................................. vi
    Notes on terminology ................. vii
    Where to find more information .. vii
    Making comments on this book .......... viii

Chapter 1. Logging on and off ........... 1
Logging on .......................................... 1
Leaving, logging off, closing, and shutting
down ............................................ 4

Chapter 2. A quick tour around WebSphere
    Voice Response ................................. 7
    The access menu ................................ 7
    The configuration menu ...................... 7
    The operations menu ....................... 8
    The applications menu .................. 10
    The help menu ................................ 11

Chapter 3. Introducing the interface .... 13
Mouse buttons .................................. 13
Using the keyboard .......................... 15
    General ..................................... 15
    Manipulating windows ...................... 15
    Selecting from lists ................... 16
    Moving the input focus .................. 16
    Moving the cursor ..................... 17
    Editing text ............................. 17
    Displaying menus ...................... 17
Windows ........................................ 18
    Container windows ..................... 19
Menus ........................................... 20
Pushbuttons .................................. 21
    Example 1 - New Application window . 21
    Example 2 - Enter Data window ...... 21
    Example 3 - Confirm Request window . 21
Check boxes, radio buttons, and drop-down
buttons ....................................... 21
Input fields and work areas .............. 22
Scrolling and searching ................. 24
    Scrolling ............................. 24
    Searching ............................. 24

Chapter 4. An A to Z of WebSphere Voice
Response windows .......................... 41
    Applications and Application windows ... 41
    Dependencies windows .................. 43
    File Search window .................... 45
    Object Index window ................... 46
    State Table window: the Action Palette and
    folders ................................ 47
    State Table window: folders and actions 48
    State Table window: actions and states .. 51
    System Configuration windows .......... 54

Appendix A. Using an ASCII display .... 57
Using an ASCII editor to create voice
applications .................................. 57
Command-line import and export utilities .. 58
The ASCII console for system management .... 58
    Starting the ASCII console .......... 58
    Using the ASCII console panels .... 60

Appendix B. Changing the appearance of
the graphical user interface .......... 63
Using the graphical user interface with large
fonts and high contrast .................... 63

Notices .......................................... 65
Trademarks .................................. 67

Glossary ......................................... 69

© Copyright IBM Corp. 1991, 2009
About this book

This book introduces the IBM® WebSphere® Voice Response for AIX® with DirectTalk® Technology user interface, and sets out general techniques for using WebSphere Voice Response windows. It describes:

- How to log on and log off
- How to use the components of the WebSphere Voice Response user interface
- How to use different kinds of WebSphere Voice Response windows

The appendix describes how to use the ASCII console as an alternative to the graphical user interface.

After mastering the information in this guide, you will find it easier to carry out the procedures in the other WebSphere Voice Response books. You can also use this guide as an ongoing reference when you are working with WebSphere Voice Response.

Throughout this book, the WebSphere Voice Response for AIX voice processing system is referred to as WebSphere Voice Response.

Who should use this book

This book is for anyone who uses WebSphere Voice Response.

If you are unfamiliar with the AIX operating system or with using a keyboard and mouse, you might find the information in Quick Beginnings useful.

How to use this book

Typographic conventions

This book uses the following typographic conventions:

**boldface**

Identifies an item that is in a WebSphere Voice Response window. The item might be a keyword, an action, a field label, or a pushbutton. Whenever one of the steps in a procedure includes a word in boldface, look in the window for an item that is labeled with that word.

**boldface italics**

Are used for emphasis. Take extra care wherever you see bold italics.
Identify one of the following:

- **New terms** that describe WebSphere Voice Response components or concepts. A term that is printed in italics is usually followed by its definition.
- **Parameters** for which you supply the actual names or values.
- References to other books.

Identifies one of the following:

- Text that you type in an AIX window. Because AIX is case sensitive, ensure that you type the uppercase and lowercase characters exactly as shown.
- Names of files and directories (path names).

### Accessibility

WebSphere Voice Response for AIX is a voice application enabler. The applications that are developed to run on WebSphere Voice Response provide telephone access to business data and services. In this way, WebSphere Voice Response provides accessibility for people who cannot access the data and services by using regular Web pages or traditional graphic interfaces. These telephone user interfaces are fully accessible to people who are blind or have low vision and, if speech recognition is used, to people with mobility impairments or limited hand use. Speech recognition capability can be provided by products such as IBM WebSphere Voice Server. In addition, support for users of Telephony Devices for the Deaf (TDD) is provided as part of the WebSphere Voice Response product.

With WebSphere Voice Response you can perform many application development and system administration tasks with a text editor or line commands—these are accessible if you use a screen reader product to interface with them. Also, the default settings of the WebSphere Voice Response graphical user interface can be changed to produce large fonts and high contrast colors. Details of how to use these accessibility features can be found in this book in Appendix A, “Using an ASCII display,” on page 57 and Appendix B, “Changing the appearance of the graphical user interface,” on page 63. Alternatively, application development can be done with Java™ or VoiceXML development tools that are supplied by IBM and third parties.

You can also use a screen-reader product to access the WebSphere Voice Response publications in HTML format (for details of their availability refer to “List of WebSphere Voice Response and associated documentation” on page 73 at the back of this book).

### Notes on terminology

- A glossary of commonly-used terms is at the end of this book.
• The full product name of WebSphere Voice Response for AIX with DirectTalk® Technology is generally abbreviated in this book to WebSphere Voice Response.

• The term pSeries® is generically used in this book to refer both to PCI-based RS/6000® computers and to appropriate models of the System p5® and pSeries ranges. (Consult your IBM representative for details of models that are supported for use with WebSphere Voice Response.) RS/6000 computers with an MCA bus are not supported.

• The IBM Quad Digital Trunk Telephony PCI Adapter is generally referred to in this book by its abbreviation DTTA. This adapter is a replacement for the IBM ARTIC960RxRx Quad Digital Trunk PCI Adapter, which is generally referred to by the abbreviation DTXA. The DTXA is not supported with WebSphere Voice Response Version 6.1.

• References made to the VoiceXML 2.1 specification are intended to include VoiceXML 2.0 unless otherwise specified.

Where to find more information

The information provided in the WebSphere Voice Response library will help you complete WebSphere Voice Response tasks more quickly. A complete list of the available books and where you can obtain them is shown in “List of WebSphere Voice Response and associated documentation” on page 73.

Useful Web sites

The following Web sites are useful sources of information about WebSphere Voice Response and related products:

WebSphere Voice Response

IBM WebSphere developerWorks resources (including WebSphere Voice products)

VoiceXML Version 2.0 and 2.1 specifications
http://www.w3.org/TR/voicexml21/
http://www.w3.org/TR/voicexml20/

CCXML Version 1.0 specification
http://www.w3.org/TR/2007/WD-ccxml-20070119/

Genesys
For more information on Genesys products go to the Genesys Web site at http://www.genesyslab.com
Making comments on this book

If you especially like or dislike anything about this book, feel free to send us your comments.

You can comment on what you regard as specific errors or omissions, and on the accuracy, organization, subject matter, or completeness of this book. Please limit your comments to the information that is in this book and to the way in which the information is presented. Speak to your IBM representative if you have suggestions about the product itself.

When you send us comments, you grant to IBM a nonexclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

You can get your comments to us quickly by sending an e-mail to idrcf@hursley.ibm.com. Alternatively, you can mail your comments to:

User Technologies,
IBM United Kingdom Laboratories,
Mail Point 095, Hursley Park,
Winchester, Hampshire,
SO21 2JN, United Kingdom

Please ensure that you include the book title, order number, and edition date.
Chapter 1. Logging on and off

This chapter describes how to log on to, and log off from, WebSphere Voice Response. It also describes how to move between WebSphere Voice Response and AIXwindows®, and how to shut down and restart the application.

Logging on

This section describes how to log on to WebSphere Voice Response, starting the system if necessary. It assumes that you are using a terminal or workstation running in an X-Windows environment.

For information on using WebSphere Voice Response from a remote terminal, see “Starting WebSphere Voice Response from a remote terminal” on page 3.

If you don’t have a graphical display, you can still use a range of WebSphere Voice Response functions using either the ASCII Console (see Appendix A, “Using an ASCII display,” on page 57), or the AIX command line. The AIX command line can be used with a screen reader (see “Using a screen reader with the AIX command line” on page 40.)

Prerequisites

- You need to know the name of your display. This is normally stored in the $DISPLAY variable. To find the value of the variable, type the following command on an AIX command line and press Enter:
  ```
  echo $DISPLAY
  ```
  If this variable has not been set, contact your system administrator.

- You need to know the name of the AIX account set up for WebSphere Voice Response. The default account is dtuser.

Procedure

If WebSphere Voice Response is not already running, you need to start the application before logging on. Otherwise, you can log on using the Access menu.

1. **Starting WebSphere Voice Response:** At the AIX Command Line, log on to the AIX user account that is set up for WebSphere Voice Response (normally dtuser).

2. If you are using the Common Desktop Environment (CDE), type the following command and press Enter:

   ```bash
   . ~/.profile
   ```
3. If the account is set up appropriately, the system displays the following menu:

   WebSphere Voice Response User Login
   1) Start WebSphere Voice Response Processes
   2) Do Not Start WebSphere Voice Response
   Enter choice (or <ENTER> for option list)

   If the Login menu is not displayed, type the following command on the AIX command line and press Enter:
   
   vaeinit

4. Type 1 and press Enter. (If you type 2 you can return to this point by entering vaeinit.)

5. If your display variable is not already set, the system prompts you for a display name. Type your display name, using the following format:

   name:number

   where name is the name of the display, and number is the session number (normally 0); for example, magpie:0. Press Enter.

   The system displays the Status window; most of the time, you can keep this window minimized. The system then displays the Welcome window and the Logon window:

   ![WebSphere Voice Response Logon Window]

6. If you have not yet created any other administrator profiles, enter admin in the Administrator Profile Name field; otherwise enter the name of
your administrator profile. Note that the field is case-sensitive, so be careful about typing uppercase or lowercase characters as appropriate.

7. Press Tab to move the input focus to the **Password** field.

8. Type your password in the **Password** field. This field is also case-sensitive. The supplied password for **admin** is also **admin**.

   **Attention:** It is preferable that you change the default setting for the administrator password; see the *Configuring the System* guide for details.

9. Click **Logon**, or press Enter.

   The system activates all menus on the Welcome window menu bar:

   ![Welcome window](image)

10. **Logging on when WebSphere Voice Response is already running:** Select Welcome window —> Access —> Logon

    In the WebSphere Voice Response guides, this is the convention for showing that you need to select an option from a menu. It means "click **Logon** from the **Access** menu in the Welcome window".

    The system displays the Logon window. Follow Step 6 on page 2 to Step 9 to complete logon.

**Starting WebSphere Voice Response from a remote terminal**

A remote terminal is one that enables you to access the server system on the network using the `telnet` command.

Before a remote terminal can display the WebSphere Voice Response windows, you need to give the server system permission to display the windows on the remote terminal. You also need to be running an X server on the remote terminal.

1. **Start:** Log on to the remote terminal.
2. **Starting AIXwindows**: If you are using AIXwindows and it does not start automatically, type `startx` and press Enter. The system starts AIXwindows.
3. **Giving the server permission**: If you are using a UNIX system, type `xhost +name`, where `name` is the name of your server system, and press Enter.
4. Type `telnet name`, where `name` is the name of your server system, and press Enter.
5. Log on to the AIX user account that is set up for WebSphere Voice Response (normally `dtuser`). This should start the initialization sequence. If it does not, type `vainit` and press Enter.
   - The WebSphere Voice Response User Login menu is displayed. Follow Step [4 on page 2] to Step [9 on page 3].

You can now continue to use WebSphere Voice Response on the remote terminal.

**Leaving, logging off, closing, and shutting down**

This section explains the differences between shutting down WebSphere Voice Response, closing the Welcome window, logging off, and temporarily leaving the WebSphere Voice Response windows.

**Moving between AIX and WebSphere Voice Response**

You can temporarily return to AIX from WebSphere Voice Response to issue commands and perform other work. If you have an AIX window open on your screen, click on the window to activate it, then enter AIX commands.

To return to WebSphere Voice Response, click on a WebSphere Voice Response window.

**Logging off**

When you have completed your work with WebSphere Voice Response, follow these steps to log off the system:

1. Close all windows until only the Welcome window is displayed.
   - In windows with a menu bar, click **File —> Close**. In other windows, select the appropriate push-button (**Close**, **OK**, **Yes**, or **Cancel**).
2. Click **Access —> Logoff**.
   - The Logoff window is displayed:

   ![Logoff Window](image)

3. Click **Logoff**.
The system deactivates all other menus on the Welcome window menu bar.
If you want to log on again using either the same Administrator Profile or a different one, click Access —> Logon.

4. Click Access —> Close to close the Welcome window.

**Closing the Welcome window**

If you click Access —> Close on the Welcome window, all WebSphere Voice Response windows (including the Welcome window) close and you are automatically logged off. The WebSphere Voice Response system is still running, so applications can answer incoming calls or make outgoing calls. To display the Welcome window again, type vaeinit on the AIX command line.

**Shutting down WebSphere Voice Response**

To shut down WebSphere Voice Response, click the Operations menu, then click one of the following options:

**Immediate Shutdown**
- Stops everything as quickly as possible. Any telephone calls in progress are ended instantly.

**Quiesce Shutdown**
- Stops everything more slowly. All telephone calls in progress are allowed to complete before the system stops.

The system closes all WebSphere Voice Response windows (including the Welcome window) and you are automatically logged off. The WebSphere Voice Response system is shut down completely, so voice applications are unable to answer or make calls.

Shutdown can also be performed by using the wvrstop command on the AIX command line.

For more information, see the *Managing and Monitoring the System* guide.

**Restarting WebSphere Voice Response**

Watch the Status window and wait until you see the message “Node Manager terminating” before attempting to restart the system.

How you restart WebSphere Voice Response depends on whether you are still logged on to AIX:
- If you are still logged on to AIX, enter the vaeinit command on the AIX command line.
• If you logged off from AIX, log on as the WebSphere Voice Response user (dtuser).

For more information, see the Managing and Monitoring the System guide.
Chapter 2. A quick tour around WebSphere Voice Response

This chapter gives an overview of the WebSphere Voice Response menus and the functions you can access with them.

For a detailed description of WebSphere Voice Response’s capabilities, see the General Information and Planning guide.

The access menu

This section gives an overview of the Access menu. See “Logging on” on page 1 for more information.

Logon  Click this option to log on to the WebSphere Voice Response user interface. The interface is password-protected, and each user can have a different password. Once you are logged on, you have access to the functions specified in your administrator profile.

Logoff  Click this option to log off from your current session without closing down the WebSphere Voice Response user interface. See “Logging off” on page 4 for more information.

About  Click this option to display copyright and release information about WebSphere Voice Response.

Close  Click this option to close the Welcome window. Closing the window does not shut down the run-time system, which can continue to receive and make calls. See “Closing the Welcome window” on page 5 for more information.

The configuration menu

This section gives an overview of the Configuration menu. See “System Configuration windows” on page 54 for more information.

Pack configuration  This option can be used to configure the telephony environment by specifying your country/region, switch type, and other basic details.

System configuration  WebSphere Voice Response is installed with a default system configuration that includes the number of active telephone channels, switch signaling protocols, and other operating parameters. You can
specify new values for a wide range of system parameters, from the number of buffers in the buffer pool, to how often the system prints reports and archives statistics.

3270 session configuration
Communication Server for AIX creates sessions according to the LU 2 session profiles you define. An LU 2 session profile specifies a communication session between the pSeries computer and a remote computer using the LU 2 protocol (3270). You configure a 3270 session by assigning a 3270 server to use it.

If you are using one of the CallPath call processing products, you can also assign a session to a telephone number.

Administrator profiles
You can assign separate administrator IDs and access privileges to each person using the system. The access privileges control which functions are available to the person using a particular profile.

Application profiles
You can use application profiles to link applications to incoming calls, voice messaging resources, and state tables. Each application profile specifies a main state table which can be invoked by incoming calls and by other state tables, and which can access mailboxes and other voice messaging resources.

Subscriber classes
Subscriber classes help you limit the amount of space used for voice messages. You classify your mailbox users with one or more subscriber classes, and then set limits on the number of messages per mailbox, the number of distribution lists per mailbox, and so on.

Languages
WebSphere Voice Response supports the use of multiple languages. You can add as many languages as are required to support your use of the WebSphere Voice Response user interface and your voice applications.

Help editor
Help text is the online help information that you can access from each window. You can translate the help text into any language for which a window text database exists, or you can use the help editor to change the text to suit your needs.

The operations menu
This section gives an overview of the Operations menu. You can also start and stop servers dynamically.
System monitor
   Click this option for a real-time graphical display of:
   • CPU usage
   • Buffer pool usage
   • Hard disk usage
   • Alarm conditions
   • Trunk and channel status

3270 session manager
   You can check on the status of all 3270 sessions at a glance. You can also monitor the activity of an individual session. The information being passed back and forth is shown in real time. You can see the sequence in which the server is manipulating screens, and which fields the server is using on each screen. You can dynamically allocate sessions to 3270 servers, remove stalled sessions from service, and stop stalled 3270 servers – all without stopping WebSphere Voice Response.

Custom server manager
   You can monitor the status of your custom servers. Available information includes:
   • The AIX process ID (PID)
   • How often the custom server is used
   • How many telephone calls are accessing it
   • The last function that it executed

Statistics
   After you develop an application and start to use it, you will probably want to know how well it is working. Which options are used most often? At what point do callers usually feel satisfied and disconnect? How often does a caller ask to speak with an agent?

   WebSphere Voice Response automatically collects information about each call. You can view the information online, or have WebSphere Voice Response generate and print reports automatically at preset intervals, or whenever you want them.

Immediate shutdown
   This option closes each channel immediately without waiting for any calls to stop.

   See “Shutting down WebSphere Voice Response” on page 5 for more information.
Quiesce shutdown
This option shuts down the application more gracefully. WebSphere Voice Response monitors all channels and closes them separately as calls to each channel stop.
See “Shutting down WebSphere Voice Response” on page 5 for more information.

The applications menu
This section gives an overview of the applications menu. See “Applications and Application windows” on page 41 for more information.

Applications
Click this option to open the Applications window, which you can use to work with existing voice applications and to create new applications.

Voice segments
You can edit voice segments using a graphical representation of the sound. By editing, you can remove unwanted gaps in the voice segment.

Voice tables
Each voice segment is stored in a voice directory. Prompts can use segments from any voice directory but, to help you organize your voice segments, you can also group them logically in a voice table.

Prompts
Prompts are used in state tables to define what a caller hears and to define the logic of when and how the words are played. You can use the prompt editor, a menu-driven interface for developing prompts, or you can use an ASCII editor to develop the prompts and then import them. You can also export prompts developed using the prompt editor to ASCII format.

State tables
State tables contain the main sequence and logic of a voice application. WebSphere Voice Response includes a user interface for creating and editing state tables, using icons and text which can be directly manipulated by mouse actions.
See “State Table window: the Action Palette and folders” on page 47 for more information.

3270 servers
Click this option to define a server to WebSphere Voice Response. You can also use 3270 terminal emulation to capture the 3270 screens and define the 3270 fields to be used in the server.
Custom servers
You can define the user functions of a custom server, and define and generate its main function. After you have written and defined the functions, you can build and install the server.

The help menu
This section gives an overview of the Help menu.

On window
Click this option to display online help for the active window.

On help
Click this option to display online help on using help.
Chapter 3. Introducing the interface

This chapter introduces the components of the WebSphere Voice Response graphical user interface:

- “Mouse buttons”
- “Using the keyboard” on page 15
- “Windows” on page 18
- “Container windows” on page 19
- “Menus” on page 20
- “Pushbuttons” on page 21
- “Check boxes, radio buttons, and drop-down buttons” on page 21
- “Input fields and work areas” on page 22
- “Scrolling and searching” on page 24
- “Selecting items in lists” on page 26
- “Folders and icons” on page 27
- “Selecting icons” on page 28
- “Toolbars and hover help” on page 29
- “Using the command line” on page 30

Mouse buttons

This section describes how to use mouse buttons.

This figure illustrates that a mouse can be configured for left handed or right handed use.

Your mouse can be configured for either right-hand or left-hand use.

Throughout this book, the buttons are referred to as mouse button 1, mouse
button 2, and mouse button 3. The positions of the three buttons on a left-handed and a right-handed mouse are shown here.

The following terms are also used in this book:

**Press**

Hold down the mouse button.

**Release**

Stop holding down the mouse button.

Table 1 sets out the actions you can take with each button.

*Table 1. Mouse actions*

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>mouse button 1</th>
<th>mouse button 2</th>
<th>mouse button 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Quickly press and release the mouse button without moving the mouse.</td>
<td>Select</td>
<td>Paste</td>
<td>Display popup menu</td>
</tr>
<tr>
<td>Shift-click</td>
<td>Click while holding down the shift key.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl-click</td>
<td>Click while holding down the ctrl key.</td>
<td>Add a span of list items to a selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double-click</td>
<td>Click twice in rapid succession.</td>
<td>Open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag</td>
<td>Move the mouse while holding down the mouse button.</td>
<td>Select a group of items</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag and drop (editing state tables)</td>
<td>Drag an object to a new location and release the mouse button.</td>
<td>Move</td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Drag and drop (working with applications)</td>
<td>Drag an object to a new location and release the mouse button.</td>
<td></td>
<td>Move</td>
<td></td>
</tr>
</tbody>
</table>
Table 1. Mouse actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>mouse button 1</th>
<th>mouse button 2</th>
<th>mouse button 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-drag and drop (working with applications)</td>
<td>Drag an object to a new location and release the mouse button while holding down the ctrl key.</td>
<td></td>
<td>Copy</td>
<td></td>
</tr>
</tbody>
</table>

Using the keyboard

Although the WebSphere Voice Response windows were designed for use with a mouse, you can use the keyboard to do nearly everything.

General

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform the default action on the item that has the input focus.</td>
<td>Enter</td>
</tr>
<tr>
<td>Cycle the windows on your screen to display and activate each one in turn.</td>
<td>Alt+Tab or Alt+Esc</td>
</tr>
<tr>
<td>Highlight all items (or characters) until the Shift key is released.</td>
<td>Shift+↑ (up arrow) Shift+↓ (down arrow) Shift++ (left arrow) Shift++ (right arrow)</td>
</tr>
<tr>
<td>Cancel current activity.</td>
<td>Esc</td>
</tr>
</tbody>
</table>

Manipulating windows

If you are not using the Common Desktop Environment, you can use the following commands to manipulate WebSphere Voice Response windows. If you are using WebSphere Voice Response with the Common Desktop Environment, type Alt+Spacebar to display the system menu, then type the underlined keyboard alternative for the option (for example, L for Lower).

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower a window to the bottom of a stack of windows, retaining the active state of the window.</td>
<td>Alt+F3</td>
</tr>
<tr>
<td>Move a window to a specified position on the screen using the cursor keys.</td>
<td>Alt+F7</td>
</tr>
<tr>
<td>Resize a window to specified dimensions using the cursor keys.</td>
<td>Alt+F8</td>
</tr>
</tbody>
</table>
Reduce (minimize) a window to an icon. Alt+F9
Enlarge (maximize) a window to fill the entire screen. Alt+F10
Restore a selected maximized or minimized window to its previous size. Alt+F5
Close a window. Alt+F4

Selecting from lists

Where you can only select one item, the input focus is shown by a solid box. Where you can select several items, the input focus is shown by a dashed box.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the item or action that has the input focus.</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Select multiple adjacent items in a list.</td>
<td>Spacebar to select first item, then Shift+↓ (down arrow) to select the other items</td>
</tr>
<tr>
<td>Select each item without deselected previously selected items.</td>
<td>Spacebar to select first item, then ↓ (down arrow) to next item and Spacebar to select</td>
</tr>
<tr>
<td>Deselect the item with the input focus in a multiple selection list.</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Select all items in a multiple selection list that has the input focus.</td>
<td>Ctrl+/ (forward slash)</td>
</tr>
<tr>
<td>Deselect all items in the multiple selection list that has the input focus.</td>
<td>Ctrl- (backward slash)</td>
</tr>
</tbody>
</table>

Moving the input focus

Where you can only select one item, the input focus is shown by a solid box. Where you can select several items, the input focus is shown by a dashed box.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the input focus to the next input or selectable component group in a window.</td>
<td>Tab or Ctrl+Tab</td>
</tr>
<tr>
<td>Move the input focus to the previous input or selectable component group in a window.</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Move the input focus to the next item to the right in a group of items.</td>
<td>+ (right arrow)</td>
</tr>
<tr>
<td>Move the input focus to the previous item to the left in a group of items.</td>
<td>+ (left arrow)</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Move the input focus to the next item down in a group of items.</td>
<td>↓ (down arrow)</td>
</tr>
<tr>
<td>Move the input focus to the previous item in a group of items.</td>
<td>↑ (up arrow)</td>
</tr>
<tr>
<td>Move the input focus between the menu bar and work area.</td>
<td>F10</td>
</tr>
</tbody>
</table>

**Moving the cursor**

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page up in a scrollable list or input area.</td>
<td>Page Up</td>
</tr>
<tr>
<td>Page down in a scrollable list or input area.</td>
<td>Page Down</td>
</tr>
<tr>
<td>Scroll to the left in a scrollable list or input area.</td>
<td>Ctrl+Page Up</td>
</tr>
<tr>
<td>Scroll to the right in a scrollable list or input area.</td>
<td>Ctrl+Page Down</td>
</tr>
<tr>
<td>Move the cursor to the beginning of the current line in an input work area.</td>
<td>Home</td>
</tr>
<tr>
<td>Move the cursor to the end of the current line in an input work area.</td>
<td>End</td>
</tr>
<tr>
<td>Move the cursor to the top left corner of an input work area.</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Move the cursor to the last position of an input work area.</td>
<td>Ctrl+End</td>
</tr>
</tbody>
</table>

**Editing text**

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move selected text to a clipboard.</td>
<td>Shift+Delete</td>
</tr>
<tr>
<td>Copy selected text to a clipboard.</td>
<td>Ctrl+Insert</td>
</tr>
<tr>
<td>Copy selected text from clipboard to the cursor position.</td>
<td>Shift+Insert</td>
</tr>
<tr>
<td>Undo the effect of the most recently performed editing action.</td>
<td>Alt+Backspace</td>
</tr>
</tbody>
</table>

**Displaying menus**

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the menu whose name has the input focus.</td>
<td>Enter or Spacebar</td>
</tr>
</tbody>
</table>
Display the popup menu for the item that has the input focus.

Shift+F10

Windows

This is an example window. The figure illustrates how to use the system menu and the menu bar to perform tasks that include: closing, minimizing, maximizing, and resizing a window.

Click MOUSE BUTTON1 to display the system menu, which provides window management options, such as Close, Move, and Resize.

The menu bar. Click MOUSE BUTTON1 on the name of a menu to display the menu, see “Menus”.

The toolbar. Use MOUSE BUTTON1 to select a tool. For more information, see “Toolbars and hover help”.

Use MOUSE BUTTON1 to drag the window border to resize the window.

The window title. A name in parentheses identifies a specific object; for example, “State Table (Welcome)”. A title that says “(unnamed)” means that a new object has not yet been saved. To move the window, point at the title bar, then drag and drop using MOUSE BUTTON1.

Click MOUSE BUTTON1 to maximize the window or restore it to its previous size.

Click MOUSE BUTTON1 to minimize the window to an icon.

To activate an open window, click anywhere on it with MOUSE BUTTON1.

To display the online help for the window, select the Help menu, then select On Window.

Closing a window

To close a window that has a menu bar, you can:

• Click Close from the system menu or from the File menu
• Press Alt+F4 (the keyboard shortcut for Close).

Windows that do not have menus have one or more pushbuttons that close the window. Depending on the window, these include OK, Yes, Cancel, and Close.
Container windows

This section describes container windows. A container window lists all objects of the same type, in alphanumeric order.

Many container windows are hierarchical, displaying two lists of objects, such as prompt directories and prompts.

The **File** menu in a multiple list container window only includes the **Close** option, which closes all associated windows too. **New**, **Open**, **Print**, **Copy**, and **Delete** are listed on object-specific menus (**Directory** and **Prompt** in this example).

To view the objects in a directory, click on it with **MOUSE BUTTON1**. The objects are displayed in the second container.

To open an object for editing, double-click on it with **MOUSE BUTTON1**, or click on it and click **Open** from the appropriate menu (**Prompt** in this example).

Use the **View** menu to check the dependencies of the selected object. For more information, see “Dependencies windows”.

Use the **Window** menu to **Overlay** or **Cascade** the windows associated with the container window. The menu also lists all associated windows. To activate a window, select it from the window list.
Menus

Displaying the menu

To display a menu, you can:

- Point to the menu and click with mouse button 1
- Type the underlined keyboard alternative while pressing the Alt key.

Selecting a menu option

To select an option on a menu, you can:

- Click on the menu with mouse button 1, then click on the option.
- Display the menu, then type the keyboard alternative.
- Type the keyboard shortcut.

If you decide not to select any option on the menu, move the mouse pointer away from the menu and click mouse button 1.

Displaying a popup menu

In some windows, you can press mouse button 3 to display a popup menu. For example, in a selection list, pressing mouse button 3 displays the Search menu; pressing mouse button 3 on a state in a state table displays the State popup menu.
Pushbuttons
This section describes push buttons and how they are used in the WebSphere Voice Response windows.

**Example 1 - New Application window**

To select a pushbutton, click on it with MOUSE BUTTON1.
The default pushbutton is outlined. This is the action taken if you press ENTER.

**Example 2 - Enter Data window**
The ellipsis means that the pushbutton opens another window. For example, a pushbutton might display a list of items from which you can select.

Gray means the button is not currently selectable. When a name has been typed in the **Voice Table** field, the **OK** button becomes selectable.

Click **OK** when you are happy with your choices. **OK** closes the window and performs the selected action.

**Example 3 - Confirm Request window**

Click **Yes** or **No** depending on what you want to do. Both of these actions close this window and the previous window.

Click **Cancel** to cancel the action that you are being asked to confirm, close the window, and return to the previous window.

**Check boxes, radio buttons, and drop-down buttons**
This section describes how to use check boxes, radio buttons, and drop-down buttons.

**Check boxes**: to select an option, click in the check box with mouse button 1.
Radio buttons: to select one of a list of mutually exclusive options, click on the radio button with mouse button 1.

Drop-down buttons look like standard pushbuttons with a bar next to the label. Point to the button and press mouse button 1 to display a list of mutually exclusive options.

Use mouse button 1 to drag the mouse pointer up or down the list, and release the button when the required option is highlighted.

Input fields and work areas

This section describes input fields and work areas.
This is an example window showing how information can be input into a field.

**Input fields:** although you can type directly into input fields, many of them also have a pushbutton that enables you to select the input from a list.

**Work area:** you can use a range of standard text editing functions, including copying, pasting, and searching.

### Inserting text

Click on the appropriate position in the input field or work area with mouse button 1. Then type the text.

### Moving the cursor

Click mouse button 1 in the new cursor position. You can also use the arrow keys to move the cursor.

### Replacing text

Select the text you want to replace by dragging mouse button 1 over it, then type the new text.
Copying text

Drag mouse button 1 over the text to select it, move the mouse pointer to the position where you want to paste the text, then click with mouse button 2.

Deleting text

Use Backspace or Delete to delete characters. To delete all the text in a field, drag the mouse over all the text in the field and press Backspace.

Scrolling and searching

This section describes scrolling and searching.

Scrolling

Vertical scroll bar: To scroll, click on the slider with mouse button 1 and drag it in the required direction.

To scroll a “page” at a time, click above or below the slider in the scroll bar area. To scroll line-by-line, click on the up or down arrows at either end of the scroll bar.

Horizontal scroll bar: in this example, the slider occupies the whole scroll bar area, which indicates that there is no more information to be seen horizontally.

Searching

Searching for a list item

To move to the first item that begins with a particular character, click on the list with mouse button 1, then type the character. The first matching item in the list is highlighted. If no match is found, the system beeps.

If you hold down the Shift key, you can type a string of two or more characters. The system highlights each matching item until a unique match is found. If no match is found, the system beeps and the last matching entry is highlighted.

Searching for text
You can search for a text string in lists and in some work areas. For example, you can search for text in a state table displayed using list view. To search for occurrences of any string, position the mouse pointer in the list or work area and either click mouse button 3 or press Shift+F10 to display the Search popup menu. Click Search. The system displays the Search for Text window.

![Search for Text window](image)

Type the string, or a *regular expression* in the window and click OK. (The rules for AIX regular expressions are defined in the AIX documentation; see the Glossary for a definition.) Searching starts at the current cursor position and wraps to the top of the list when the end is reached.

Click Search —> Next from the popup menu to find the next occurrence; click Previous to find the previous occurrence.

**Searching for labels and variables**

In the State Table window, you can search for and replace the labels attached to states, and the variables used to define them. To search and replace a label, click Utilities —> Label Search. To search and replace a variable, click Utilities —> Variable Search. The system displays the appropriate Search and Replace window.
Selecting items in lists

This section describes how to select items in lists. In some lists, you can only select single items. In others, you can select multiple items.

Selecting a single item

Position the mouse pointer on the required item, then press mouse button 1. When selected, the item is highlighted.

Selecting multiple items

To select a number of adjacent items in a list, you can:

- Click mouse button 1 to select the first item, then drag the mouse pointer to the last item before releasing the button.
- Click mouse button 1 to select the first item, then position the pointer on the last item and Shift-click mouse button 1.
- Press Spacebar to select the first item, then press Shift+↓ (down arrow) to select the other items.

To add a nonadjacent item or items to a selection, you can:

- Select the first item, then Ctrl-click mouse button 1 to select further items.
- Select the first item, then move to the next item using the up or down arrow keys. Press Spacebar to select each item.

Deselecting an item

To deselect an item, you can:
• Click on another item in the list.
• Ctrl-click on the selected item (Ctrl-click toggles between selected and deselected).
• Press Spacebar.

Selecting all items

Press Ctrl+/ (forward slash).

Deselecting all items

Press Ctrl+\ (backward slash).

Folders and icons

This section describes how to use folders and icons.

In WebSphere Voice Response, icons are used to represent actions and states in the state table editor.

Folders are used to group objects within applications, and actions on the Action Palette. Some folders are created automatically by the system; others you can create and customize to suit your needs.

To work with applications, click **Applications —> Applications** from the Welcome window. The system displays the Applications window.
**Selecting icons**

This section describes how to select icons.

This figure shows an example window to illustrate the different ways that icons can be selected.
Selecting multiple icons

Position the mouse pointer on a blank piece of the window, then hold down mouse button 1 while dragging the pointer diagonally to include all the icons you want to select.

Adding to the selection

Hold down the Ctrl key while clicking on further icons with mouse button 1.

Deselecting icons

Hold down the Ctrl key while clicking on selected icons with mouse button 1.

- **Selecting all icons**: In the State Table window or the Applications window, click **Edit → Select All**.
- In an application window, click on the window with mouse button 3 to display the **Object** popup menu, then click **Select All**.
- **Deselecting all icons**: In the State Table window or the Applications window, click **Edit → Deselect All**.
- In an application window, click on the window with mouse button 3 to display the **Object** popup menu, then click **Deselect All**.

**Toolbars and hover help**

This section describes how to use toolbars and hover help.
A toolbar provides quick access to commonly used menu options. You can use toolbars in the State Table window.

Hover help tells you which option each icon on a toolbar or Action Palette represents. To display hover help, click Options —> Show Hover Help. Then point the mouse pointer at the icon you want help for.

Hover help is only shown for active icons; if an option is not currently selectable, hover help is not displayed for it. On the Action Palette, hover help is only shown if the icon text is not already displayed.

Selecting a tool

Click on the icon with mouse button 1.

• Showing and hiding the toolbar: To show or hide the toolbar, click the Options menu, then select or deselect Show Toolbar.

• To hide the toolbar, click the Hide toolbar icon: 

Using the command line

You can perform many of the tasks of managing WebSphere Voice Response from the AIX command line. There are also some commands that help with application development tasks.

Commands can provide:

• Remote access
• Automation
• Accessibility for users with disabilities

All commands can be issued from the command line, and most can be issued from scripts you can write. The command line provides accessibility, for people who use screen readers as well as those who cannot or choose not to use a graphical display. It also allows remote access from non-graphical displays. Issuing a command from a script can be used to automate tasks.
### Commands available

The commands available are shown in the following table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose</th>
<th>Permission</th>
<th>State of Voice Response system</th>
<th>More information (see Key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Starts the ASCII Console (after prompting for administrator name and password)</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>Drop_DB_Pkgs</td>
<td>Removes WebSphere Voice Response database packages from the database server of a single system image</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>dt.log_mgr</td>
<td>Merges, condenses, groups, and deletes oamtrace and errorlog files</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>dt_setowner</td>
<td>Sets, unsets and queries the owner of a DTTA or DTNA</td>
<td>root</td>
<td>stopped</td>
<td>INS</td>
</tr>
<tr>
<td>DT_shutdown</td>
<td>Shuts down WebSphere Voice Response</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTalarm</td>
<td>Displays or logs a WebSphere Voice Response alarm message</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTarchives</td>
<td>Views or prints archived log or report files</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTcs</td>
<td>Adds, lists, or removes custom server autoexec-override entries</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTdata</td>
<td>Deletes or exports data on statistics database tables</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>Name</td>
<td>Purpose</td>
<td>Permission</td>
<td>State of Voice Response system</td>
<td>More information (see Key)</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>DTdatabase</td>
<td>Creates the WebSphere Voice Response database</td>
<td>root</td>
<td>stopped</td>
<td>INS</td>
</tr>
<tr>
<td>dtexport</td>
<td>Exports application objects into application or partial export packages</td>
<td>dtuser</td>
<td>running</td>
<td>DMA</td>
</tr>
<tr>
<td>dtimport</td>
<td>Imports application or partial export packages</td>
<td>dtuser</td>
<td>running</td>
<td>DMA</td>
</tr>
<tr>
<td>dtjconf</td>
<td>Imports an editable configuration file into the Java and VoiceXML configuration database.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjenv</td>
<td>Sets environment variables for Java and VoiceXML.</td>
<td>dtuser or root</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjflog</td>
<td>Formats Java and VoiceXML log files so they can be read.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjplex</td>
<td>Performs numerous utility actions in the Java and VoiceXML environment.</td>
<td>dtuser</td>
<td>running (for most actions)</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjqapps</td>
<td>Queries waiting Java and VoiceXML applications.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjqhost</td>
<td>Queries the local Java and VoiceXML host.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjqnode</td>
<td>Queries the local Java and VoiceXML node.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
</tbody>
</table>
Table 2. WebSphere Voice Response commands and utilities (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose</th>
<th>Permission</th>
<th>State of Voice Response system</th>
<th>More information (see Key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>dtjconf script</td>
<td>Imports a configuration file into the configuration database. Whenever the default.cff file is modified, dtjconf script must be run to make the changes take effect.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjhost</td>
<td>Starts (or stops) the local Java and VoiceXML host.</td>
<td>dtuser</td>
<td>not applicable</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjstart</td>
<td>Starts Node1 in the local host and starts all applications included in any groups that are included in Node1.</td>
<td>dtuser</td>
<td>running</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjstop</td>
<td>Quiesces all applications and all nodes on the local host.</td>
<td>dtuser</td>
<td>running</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjterm</td>
<td>Stops immediately all applications and all nodes on the local host.</td>
<td>dtuser</td>
<td>running</td>
<td>DMVJ</td>
</tr>
<tr>
<td>dtjver</td>
<td>Reports the current version of Java and VoiceXML environment.</td>
<td>dtuser</td>
<td>running</td>
<td>DMVJ</td>
</tr>
<tr>
<td>DTLogs</td>
<td>Archives, lists, prints, or views log files</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTIsapobj</td>
<td>Lists information about a type of WebSphere Voice Response application object</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>Name</td>
<td>Purpose</td>
<td>Permission</td>
<td>State of Voice Response system</td>
<td>More information (see Key)</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>DTsvmobj</td>
<td>Lists information about a type of WebSphere Voice Response voice messaging object</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTmon</td>
<td>Displays information about system resources</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTprompt</td>
<td>Imports from, and exports to, an AIX file the ASCII source of a WebSphere Voice Response prompt</td>
<td>dtuser</td>
<td>running</td>
<td>ST</td>
</tr>
<tr>
<td>DTreports</td>
<td>Archives, lists, prints, or views standard reports</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTSNMPD_START</td>
<td>Starts the WebSphere Voice Response SNMP daemon</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>DTist</td>
<td>Imports from, and exports to, an AIX file the ASCII source of a WebSphere Voice Response state table</td>
<td>dtuser</td>
<td>running</td>
<td>ST</td>
</tr>
<tr>
<td>DTverifydb</td>
<td>Verifies the WebSphere Voice Response database</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>ISDN_MONITOR</td>
<td>Displays and decodes frames and messages passed between the switch and WebSphere Voice Response trunks.</td>
<td>dtuser</td>
<td>running and trunks in service</td>
<td>PD</td>
</tr>
<tr>
<td>print_trace</td>
<td>Formats WebSphere Voice Response trace files</td>
<td>dtuser</td>
<td>running or stopped</td>
<td>PD</td>
</tr>
<tr>
<td>RDSETBUFS</td>
<td>Resets the size of the buffer pool</td>
<td>dtuser</td>
<td>running or stopped</td>
<td>CF</td>
</tr>
<tr>
<td>Name</td>
<td>Purpose</td>
<td>Permission</td>
<td>State of Voice Response system</td>
<td>More information (see Key)</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>restoreDT</td>
<td>Restores WebSphere Voice Response data that was saved using the saveDT command</td>
<td>root</td>
<td>stopped</td>
<td>INS</td>
</tr>
<tr>
<td>run_script</td>
<td>Logs on or off a 3270 server</td>
<td>dtuser</td>
<td>running</td>
<td>3270</td>
</tr>
<tr>
<td>saveDT</td>
<td>Saves WebSphere Voice Response data</td>
<td>root</td>
<td>stopped</td>
<td>INS</td>
</tr>
<tr>
<td>ssimkclient</td>
<td>Configures a WebSphere Voice Response system as a client node within a single system image</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>ssimksvr</td>
<td>Configures a WebSphere Voice Response system as a server node within a single system image</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>ssirmclient</td>
<td>Removes a client node from a single system image</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>ssirmssvr</td>
<td>Removes a server node from a single system image</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>ssistatus</td>
<td>Displays how the WebSphere Voice Response system is configured within a single system image</td>
<td>dtuser</td>
<td>running or stopped</td>
<td>CF</td>
</tr>
<tr>
<td>vae.setenv</td>
<td>Sets WebSphere Voice Response environment variables</td>
<td>dtuser or root</td>
<td>running or stopped</td>
<td>INS</td>
</tr>
<tr>
<td>vae.setuser</td>
<td>Defines the WebSphere Voice Response user ID and file permissions</td>
<td>root</td>
<td>stopped</td>
<td>INS</td>
</tr>
</tbody>
</table>
Table 2. WebSphere Voice Response commands and utilities (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose</th>
<th>Permission</th>
<th>State of Voice Response system</th>
<th>More information (see Key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaeinit</td>
<td>Starts WebSphere Voice Response</td>
<td>dtuser</td>
<td>stopped (but if running already, starts the graphical user interface)</td>
<td>MM</td>
</tr>
<tr>
<td>vaeinit.nox</td>
<td>Starts WebSphere Voice Response without XWindows</td>
<td>dtuser</td>
<td>stopped</td>
<td>CF</td>
</tr>
<tr>
<td>vxml</td>
<td>Allows you to run VoiceXML applications remotely.</td>
<td>any user</td>
<td>running</td>
<td>BE</td>
</tr>
<tr>
<td>wvrapplprof</td>
<td>List, add, change, delete, copy, or view details of an application profile.</td>
<td>dtuser</td>
<td>running, Before you can use the wvrapplprof command, you must import the admin custom server and make sure that it is running.</td>
<td>DMA</td>
</tr>
<tr>
<td>wvrmailbox</td>
<td>List, change, or view details of mailboxes associated with an application profile. The application profile must already exist (see wvrapplprof).</td>
<td>dtuser</td>
<td>running, Before you can use the wvrmailbox command, you must import the admin custom server and make sure that it is running.</td>
<td>DMA</td>
</tr>
<tr>
<td>wvrstop</td>
<td>Stop the WebSphere Voice Response runtime system.</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
<tr>
<td>wvrtrunk</td>
<td>Enable, disable, or query the status of one or more trunks and their channels.</td>
<td>dtuser</td>
<td>running</td>
<td>MM</td>
</tr>
</tbody>
</table>
Table 2. WebSphere Voice Response commands and utilities (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose</th>
<th>Permission</th>
<th>State of Voice Response system</th>
<th>More information (see Key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key: DMVJ: Deploying and Managing VoiceXML and Java Applications; CF: Configuring the System; DMA: Designing and Managing State Table Applications; INS: Installation; MM: Managing and Monitoring the System; PD: Problem Determination, ST: Application Development using State Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Executing the commands

By default the dtuser account is set up to run vaeinit at start up. The vaeinit dialog asks you to select 1 to start WebSphere Voice Response processes or 2 to not start WebSphere Voice Response.

To use the command line, respond by typing 2 (this will not start the GUI). Then, to start WebSphere Voice Response processes, type the following command and press Enter:

```
vaeinit.nox
```

This takes a few moments, but when the prompt returns, you can use WebSphere Voice Response command line tools.

For a few of the commands, you need to be logged on as root, and you need to execute the command that sets the dtuser’s environment before you execute the command. To do this, type the following command and press Enter:

```
./usr/lpp/dirTalk/tools/vae.setenv
```

Some of the commands are interactive. For the interactive commands, when you press Enter, a prompt appears on the screen. Follow the instructions given by the prompts.

Most of the commands are non-interactive. Some of these have no syntax and perform only one function when you execute them. Others have one or more flags that modify the action of the command. Some flags are followed by one or more parameters. To execute a non-interactive command, type the name of the command followed by the flags and parameters appropriate for the task you want to perform. Then press Enter.

The non-interactive commands are non-blocking, which means that they return control to you immediately (without waiting for the command to finish).
Syntax rules

This section describes the rules for entering flags and parameters for non-interactive commands. These rules only apply to commands beginning with ‘wvr’.

Flags

Flags can be typed in any order. The flag and its parameter can be separated by an optional space. For example,

wvrtrunk -q -t 1-6

In this example, the command name is wvrtrunk, the action flag is -q (no parameters) and the other flag is -t (parameter is 1-6).

This command could also be entered as
wvrtrunk -t1-6 -q

And it means: view the status of trunks 1 to 6.

If there are multiple flags and no more than one of them has a parameter, they can be concatenated together after a single hyphen. In this example, two flags are concatenated together, because only the last has a parameter:

wvrtrunk -et all

This example could also be entered as:

wvrtrunk -e -t all

And it means: enable all trunks but with no channels in service.

Most action flags are lowercase; some are uppercase. The uppercase flags generally fall into two categories:

• Potentially destructive flags such as -I for immediate shutdown on wvrstop
• Attributes of objects being created or modified

Table 3 on page 39 lists the action flags. On many commands there is no flag for printing details of an object. If the command produces too much output to view conveniently on a single screen, the output can be redirected to a file and browsed with another viewer, or printed.

For example, the following command sends the details of the application profile named “Banking” to a file called profile.txt:

wvrapplprof -v -N "Banking" > profile.txt
Table 3. General meanings for action flags

<table>
<thead>
<tr>
<th>Flag</th>
<th>General meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a</td>
<td>add an object to a container object; contrast with -n</td>
</tr>
<tr>
<td>-c</td>
<td>copy an object, creating an identical object with a different name</td>
</tr>
<tr>
<td>-d</td>
<td>delete an object; contrast with -r</td>
</tr>
<tr>
<td>-h</td>
<td>display help</td>
</tr>
<tr>
<td>-l</td>
<td>list all objects</td>
</tr>
<tr>
<td>-m</td>
<td>modify the attributes of an object</td>
</tr>
<tr>
<td>-n</td>
<td>create a new object, specifying mandatory attributes; contrast with -a</td>
</tr>
<tr>
<td>-p</td>
<td>stop</td>
</tr>
<tr>
<td>-q</td>
<td>query the current status of a runtime object; contrast with -v</td>
</tr>
<tr>
<td>-r</td>
<td>remove an object from a container; contrast with -d</td>
</tr>
<tr>
<td>-s</td>
<td>start</td>
</tr>
<tr>
<td>-v</td>
<td>view the attributes of an object; contrast with -q</td>
</tr>
<tr>
<td>-y</td>
<td>verify</td>
</tr>
</tbody>
</table>

Parameters

Parameters must not contain imbedded spaces. If they do, they must be enclosed in quotes (the need for this is avoided where possible). A parameter can be, for example, a name of an object, a keyword, a range, or a single number. A range is expressed as number hyphen number (no spaces).

Getting help

Online help

To view the full explanation of some commands and how to use them, enter a command name followed by the -h flag. To view the syntax, enter a command name followed by the -? flag. The syntax or "usage" part of the online help is also displayed if you enter invalid syntax. Online help is only provided for some commands. Other help can be found by referring to the books suggested in Table 2 on page 31.

Syntax notation

The syntax notation is as follows:

- Braces { } mean you must include one item from within them.
- Vertical bar | separates the items within the braces.
- Square brackets [ ] mean that the items within them are optional.
• Three dots ... mean that you can specify multiple instances of the preceding item.
• Italics are used for parameter values in the documentation, but not in the online help.

Using a screen reader with the AIX command line

With a screen reader, you can use WebSphere Voice Response line commands to do many administration and development tasks. If you are using a screen reader (for example, Freedom Scientific JAWS) on a Windows system, and you can telnet from that system to the WebSphere Voice Response system, you can use these line commands remotely.

Hints for using the command line effectively

• Screen readers work by noticing changes on the screen, and this can mean that old information gets read that the screen reader believes to be new. To avoid this, you can clear the screen by typing the following before any command:
  clear;

• When listing, querying, or viewing information, if the output is lengthy, all the information except for the last full screen will disappear off the screen before the screen reader has a chance to read it. To prevent this happening, type the following at the end of the command:
  | pg
This shows you one page at a time. A colon (:) alone on a line indicates that there is more to come. To show the next page, press Enter. Keep doing this until you get to a line that says:
  (EOF)
Press Enter to return to the command prompt.
For example, to list the files in the current directory, type the following command and press Enter:
  clear;ls | pg
Chapter 4. An A to Z of WebSphere Voice Response windows

This chapter introduces you to some of the main WebSphere Voice Response windows:

- "Applications and Application windows"
- "Dependencies windows" on page 43
- "File Search window" on page 45
- "Object Index window" on page 46
- "State Table window: the Action Palette and folders" on page 47
- "State Table window: folders and actions" on page 48
- "State Table window: actions and states" on page 51
- "System Configuration windows" on page 54

Applications and Application windows

The Applications window shows all the applications in your database. You can use the window to work with an existing application, or to create a new one.

You can work with applications using the mouse and toolbars, the menus, or the Application popup menu.
Creating a new application

You can:

- Click **Application --> New**
- Click **Application --> New** from the popup menu.

The system displays the New Application window. Enter the application name and description (optional), then click **Create**. The system displays the Application window for the new application.

Opening an application

You can:

- Double-click on the application icon with mouse button 1.
- Click **Application --> Open** from the popup menu.
- Select the application, then click **Application --> Open**.
- Select the application, then press Enter.

The system displays the Application window for the application. You can use the window to develop and manage all of the components of the voice application.

Creating a new object

You can:

- Click **Object --> New**, then select the object type.
- Click **Object --> New** from the popup menu.

Moving an object

You can:
• Drag the object to a different application, using mouse button 2.
• Click **Object —> Move**.
• Click **Move** from the popup menu when an object is selected.

**Copying an object**

You can:
• Drag the object to a different application, using mouse button 2.
• Click **Object —> Copy**.
• Click **Copy** from the popup menu when an object is selected.

**Checking the dependencies of an object** Before deleting an object, it’s advisable to check its dependencies, to ensure that:
• No other objects require it.
• You know which other objects might no longer be required.

To check the dependencies of an object, you can:
• Click **Object —> Dependencies**.
• Click **Dependencies** from the popup menu when an object is selected.

**Deleting an object**

You can:
• Select the object, then click **Object —> Delete**.
• Select the object, click on the object with mouse button 3, then click **Delete** from the popup menu.

**Customizing your view**

You can:
• Click **View —> Sort** to sort the objects or applications by name or modification date.

---

**Dependencies windows**

Application objects *use* and are *used by* other objects. For example, a state table *uses* prompts and prompt directories, and is *used by* application profiles. These relationships between objects are known as *dependencies*.

You might need to know the dependencies of objects when you are copying, exporting, or deleting them. You can view the dependencies of an object either from an Application window, or from an object container window, such as the Prompt Directories and Prompts window.

From an Application window, you can:
Click **Object —> Dependencies**.

Select the object, then click **Object —> Dependencies** from the popup menu.

The system displays a Dependencies window, showing the object you selected and the other objects it depends on. You can use this window to collect a group of related objects.

From an object container window, you can view the dependencies of an object, and of the objects it depends on. Select the object, then click **View —> Dependencies**.

In this example, the System_Macros Prompt Directory uses the Month_of_Year Voice Table, which in turn uses the System Voice Directory.
The File Search window is displayed whenever you need to select an AIX file name, either to import a file into WebSphere Voice Response or to export data into an AIX file.

AIX files are grouped into directories. A directory can also contain another directory. All files and directories are organized into a tree structure. At the top is a single directory known as root or /. Each file and directory has a path name, which starts with / and includes all the directory names from the root directory to it.
The Object Index window lists all of the objects in your database. You can use it to find an object when you don't know what application it is in. To open the index from the Applications window, you can:

- Click Options —> Show Object Index
State Table window: the Action Palette and folders

A state table consists of a sequence of actions that carry out the activities of a voice application and move the current position of the call between different states in the state table. The state table window provides a graphical environment in which you can create and edit state tables quickly and easily. The window is displayed whenever you open a state table or create a new one.

The Action Palette contains state table actions that you can drag onto the canvas to create states in the state table. (For more information about creating states using actions, see “State Table window: actions and states” on page 51.) The actions are grouped into folders.

To display the popup menu for an object, such as a state table, select the object using MOUSE BUTTON1, then click on the window with MOUSE BUTTON 3.

To create a new object, click New, or click Object --> New and then select the object type. The new object is added to the Default application.

To open the state table, click Open. The system displays the State Table window.
Using list view

You can also display a text version of the state table. Click View —> List View. The system displays the state table as a list of states. To change back to the graphical view, click View —> Icon View.

State Table window: folders and actions

Initially, the Action Palette contains only the folders supplied with the system. You cannot change or delete these folders, but you can remove them from the Action Palette, then reload them later if you need them. You can also create your own folders, copying actions from the system folders and then customizing them, enabling you to create frequently used states quickly and easily.
When you close the state table, the current set of folders on the action palette is saved, and is used by any state table opened for editing subsequently.

Viewing hover help: Hover help tells you what action each icon on the Action Palette and toolbar represents. Point the mouse pointer at an icon to display hover help. (If no hover help is displayed, click Options —> Show Hover Help. Hover help is not shown if the icon text is already being displayed.)

Viewing text and icons: You can display the actions on the Action Palette using text, icons, or both. To change the way all of the actions are displayed, click on the Action Palette title bar with mouse button 3 to display the Action Palette popup menu. To change the way that the actions in a single folder are displayed, click in the folder with mouse button 3 to display the Folder popup menu. Click Show Text Only, Show Icons Only, or Show Icons and Text. (You can still drag and drop actions displayed as text.)

Rearranging folders: Click Pack All from the Action Palette popup menu to pack the icons in all folders into the smallest possible space. Click Folder —> Pack from a popup menu to pack the icons in an individual folder.

Click Action Palette —> Align All from the popup menu to arrange the icons in all folders into lines and rows. Click Folder —> Align from a popup menu to align the icons in an individual folder.

Adding a folder to the Action Palette: Click on the Action Palette title bar with mouse button 3 to display the Action Palette popup menu. You can use this menu to create a New folder or Load an existing folder and all its icons into the Action Palette.

Copying an action to a folder
To copy an action from one folder to another, you can:

- Select an icon (or name) on the Action Palette and drag it to the new folder using mouse button 2.
- Select an icon (or name) on the state table canvas and drag it to the new folder using mouse button 2. The new action has the same attributes as the state you copied.
- Click on an icon (or name) on the Action Palette with mouse button 3 to display the Action popup menu, then click Copy.

**Moving an action to a folder**

To move an action from one of your own folders to another, you can:

- Drag it with mouse button 1.
- Click on the action with mouse button 3 to display the Action popup menu, then click Move.

**Removing a folder from the Action Palette:** Click in the folder’s title bar or background with mouse button 3 to display the folder popup menu, then click Unload Folder. This does not delete the folder from the system, it only removes it from the Action Palette.

**Deleting folders and actions:** To delete one of your own folders completely, click Delete Folder from the folder popup menu. To delete an action from one of your folders, click on the icon with mouse button 3 to display the popup menu, then click Delete.

**Renaming folders** To change the name of one of your folders, double-click mouse button 1 on the name and type over it. Press Enter when you have finished.

**Renaming actions:** To change the name of an action in one of your folders, click on the action with mouse button 3 to display the Action popup menu, then click Rename. The name is highlighted, and a cursor is displayed at the end of the name. Change the name, then press Enter. Deselect the action to refresh the display.

**Customizing actions:** You can customize the actions in your folders, so that you can create frequently used states quickly and easily. To change the settings for an action, you can:

- Double-click mouse button 1 on the action.
- Click on the action with mouse button 3 to display the Action popup menu, then click Open.
The system displays the Action window. To change the settings, type in some or all of the details, then click **OK**. You can now use the customized action in this and other state tables.

**Reloading system folders**

Click on the Action Palette title bar with mouse button 3 to display the Action Palette popup menu, then click **Load**. The system displays the Load window. Select the **System folders** radio button, select the folders from the **Items** list, then click **OK**.

**State Table window: actions and states**

This section describes the State Table window and how to use it to define actions and states.

This figure illustrates how a plus sign and a minus sign can be used to expand and collapse a category, respectively.

To create a new state, drag the appropriate action from the Action Palette, using mouse button 1, and drop it into position on the canvas. You can create several states at a time, or one after the other, before filling in any of the details or connecting the states together.

The possible results of the action are grouped into categories such as Failure and Success.

**Filling in the details**

You can:
- Double-click on the state icon with mouse button 1.
- Select the state, click on it with mouse button 3 to display the **State** popup menu, then click **Open**.
The system displays the details window for the state. For more information about the window, refer to the online help for the window, or to the information in the *WebSphere Voice Response for AIX: Application Development using State Tables*.

**Connecting the states**

Each of the possible results of a state needs to be connected to the next appropriate state. For example, a Caller Hung Up result could be connected to a CloseEverything state. To connect one or more results to a state, you can:

- Click on the results or result groups with mouse button 1. Position the mouse pointer over the destination state. The mouse pointer changes to the connection pointer. Click on the destination state. The system displays a line, showing the connection, and the mouse pointer changes back to an arrow.

To select results, you can either click on a single result or result group with mouse button 1, or drag mouse button 1 to select adjacent results. Ctrl-click mouse button 1 to add non-adjacent results to the selection.

- Click *Utilities —> Labels* to display the Labels window. The window lists the labels for all of the states in the state table. Open the details window for the state whose results you want to work with. The window contains text fields for each of the results of that state. Select the text field for the result you want, select the appropriate label from the Labels window, then click the *Select* push button. Click *OK* in the Action window.

**Finding the state to which a result is connected:** Select the result and click with mouse button 3 to display the *Result* popup menu, then click *Go to Destination*. The destination state is selected.

**Finding the states connected by a line:** Select the line and click with mouse button 3 to display the *Line* popup menu. To find the destination of the line, click *Go to Destination*. To find the source of the line, click *Go to Source*.

**Reducing line clutter manually:** To reduce the number of lines on your canvas, you can convert lines into a *stub*. You can:

- Select the lines and click with mouse button 3 to display the *Line* popup menu, then click *Stub*.
- Select the lines, then click *Edit —> Make Stub*.
- Select the source results and click with mouse button 3 to display the *Result* popup menu, then click *Stub Results*.

**Reducing line clutter automatically:** You can automatically convert lines into stubs whenever they become too long. Click *Utilities —> Autostubbing*. The system displays the Autostubbing window:
Type the maximum number of columns you want your lines to cross in the **Stub if columns crossed exceeds** field. Lines which cross a larger number of columns will be converted to a stub. Select a radio button for the type of line, then press Enter. The lines that meet your criteria are now displayed as stubs.

**Rerouting lines:** When you add and remove states in a state table, the lines might no longer take the shortest route between two states. To redraw the lines in a table so that they take the most efficient routes, click **View —> Reroute Lines.**

Sometimes, if you have a large number of states and connections, lines might be displayed directly on top of one another, even after they have been redrawn. In that case, move an icon to which one of the lines is connected.

**Deleting a connection**

You can:

- Select the line and click with mouse button 3 to display the **Line** popup menu. Click **Disconnect**.
- Select the text field for the result in the state details window and press Backspace or Delete.

**Copying a state**

You can:

- Drag and drop the state using mouse button 2.
- Select the state and click with mouse button 3 to display the **State** popup menu. Click **Copy**. Click with mouse button 3 on the canvas and select **Paste**.

**Moving a state**

You can:
Drag and drop the state using mouse button 1.
Select the state and click with mouse button 3 to display the State popup menu. Click Cut. Click with mouse button 3 on the canvas or Action Palette and click Paste.

Deleting a state

You can:
- Select the state, then click Edit —> Delete.
- Select the state and click with mouse button 3 to display the State popup menu. Click Delete.

Using list view

You can perform all of the same tasks in list view as you can in icon view. For example, you can still create new states by dragging actions from the Action Palette, and open the details window for a state by double-clicking on the state name.

To connect states in list view, click Utilities —> Labels to display the Labels window. The window lists the labels for all of the states in the state table. Open the details window for the state whose results you want to work with. The window contains text fields for each of the results of that state. Select the text field for the result you want, select the appropriate label from the Labels window, then click the Select push button.

Saving your settings

Both the Applications window and the State Table window automatically save the settings you last selected (whether you selected list view or icon view, for example, or whether you displayed the toolbar). The same settings will be used when you next open the window, even if you are working with a different state table.

System Configuration windows

You can use the system configuration windows to configure WebSphere Voice Response for your environment. For example, you can set system parameters to suit a variety of telephony equipment and signaling protocols.

To change the system configuration, in the Welcome window, click Configuration —> System Configuration —> Change. The system displays the System Configuration window.
Copying parameter values

If the Configuration window for a parameter group has an Edit menu, you can copy and paste a set of values from one object to another, rather than setting them individually. For example, you can copy the parameter values from one channel group to another.

To copy a set of parameter values, open the configuration window for the group, use the arrow keys to select the object you want to copy from, then click Edit —> Copy. Use the arrow keys to select the target object, then click Edit —> Paste. The values of the parameters in the target are reset to the values for the first object.

Saving your changes
After you have finished working with a parameter, click OK to close the configuration window for that parameter. Close the parameter group window and any other windows until the System Configuration window is displayed. In the System Configuration window, click File —> Save, then File —> Close.

Some system parameters take effect immediately after you save the new value. In other cases, you have to shut down and restart WebSphere Voice Response before the new value takes effect. For other parameters, you have to disable and re-enable the trunk to which the parameters apply.
Appendix A. Using an ASCII display

This appendix describes how to use an ASCII display instead of the graphical user interface.

Instead of using the graphical user interface, you can:
- Use an ASCII editor to create voice applications
- Start the import and export utilities from the AIX command line
- Use a text-based interface (the ASCII console) for system management

Using an ASCII editor to create voice applications

You can use an ASCII editor instead of the WebSphere Voice Response user interface to create the code for state tables, prompts, and 3270 server scripts. ASCII-format code can be stored in an external code repository, imported into WebSphere Voice Response, and then debugged using the WebSphere Voice Response windows. There is a command-line interface for importing ASCII state tables and prompts, so you can schedule jobs to import all changed files from your code repository automatically. User-specified version control information can be retained, after importing files into WebSphere Voice Response.

Objects imported from ASCII source files can be defined as read-only, to prevent modification within WebSphere Voice Response. However, if you prefer, an imported state table, prompt, or script can be modified within WebSphere Voice Response.

A state table, prompt, or script developed or modified using the WebSphere Voice Response user interface can be exported and then modified using your favorite editor. However, you should be aware that, if you import an ASCII state table and then export it again, the ASCII code generated by WebSphere Voice Response will not necessarily look the same as the ASCII file you originally imported. In other words, "round tripping" is not necessarily possible.

After you have learned the WebSphere Voice Response programming language, you can create new applications that reuse modules from existing applications quickly and easily.
**Command-line import and export utilities**

The import and export functions available from the window-based user interfaces are also available from the AIX command line. Using the command-line import and export utilities, you can develop applications at a central location and then distribute them to remote locations, without leaving the office. You can also import applications from a remote location, so that you can examine or debug them.

The command-line utilities are more convenient than the graphical interface if:

- You are physically distant from the other location and cannot use a graphical user interface to the other system
- You need to distribute an application to multiple sites

The command-line utilities are fully compatible with their window interface counterparts - an object exported via the window interface can be imported via the command-line utility.

The command-line utilities make it easy to package applications in such a way that importing and exporting require minimal user intervention. You can write simple shell scripts that remote users can use to import or export their own applications. Then, all the users need to do is type a single command on the AIX command line, rather than using a series of menus and buttons.

**The ASCII console for system management**

If you don't have a graphical display, you can still perform many of the tasks using the *ASCII console* (AC). This is a text-only front end for the WebSphere Voice Response software. Because it does not depend on graphics, you can start it from any terminal that AIX supports. For example, you can use a terminal connected to the pSeries computer through the RS-232 (serial) interface either directly or via a modem link.

**Starting the ASCII console**

**Prerequisites**

- To start the ASCII console, you need a WebSphere Voice Response administrator profile with access to the *Configuration* and *Operations* menus (see the *WebSphere Voice Response for AIX: Configuring the System*). If you already have an administrator profile, you do not need a new one.
- You need to know both the WebSphere Voice Response AIX account ID and password, and the WebSphere Voice Response administrator profile name and password.
Procedure

1. **Setting up the environment:** Log into the AIX user account that is set up for WebSphere Voice Response (normally `dtuser`).
   - The system displays the following menu:
     ```
     WebSphere Voice Response User Login
     1) Start WebSphere Voice Response Processes
     2) Do Not Start WebSphere Voice Response
     Enter choice (or <ENTER> for option list)
     ```

2. Type 2 and press Enter.

3. To check the setting of the TERM environment variable, type the following command and press Enter:
   ```termdef```
   - The system displays the current display type. Some examples of appropriate display types are `vt100`, `ibm3151`, or `aixterm`.

4. If the setting is not correct for your terminal, type the following command and press Enter:
   ```export TERM=terminal_type```

5. **Starting WebSphere Voice Response:** Type the following command and press Enter:
   ```vaeinit.nox```
   - If it is not already running, WebSphere Voice Response starts.

6. **Starting the ASCII console:** Type the following command and press Enter:
   ```AC```
   - The system prompts you to enter your WebSphere Voice Response administrator name.

7. Type your administrator name and press Enter.
   - The system prompts you to enter your WebSphere Voice Response administrator password.

8. Type in the password and press Enter.
   - The system displays the ASCII Console Main Menu.
Using the ASCII console panels

When you use the ASCII console, you have access to the same WebSphere Voice Response hardware, software, and files as you do when you use the graphical interface.

Like the WebSphere Voice Response windows, the ASCII console panels display information and list actions. The panels operate on the same principle as the windows: first select information, then select the action you want to perform on the information. The main difference between using the windows and using the panels is the way in which you select the information and the actions.

Selecting information and actions

Both windows and panels display information. The WebSphere Voice Response windows list each possible action as an entry on a menu or as a pushbutton. Each ASCII console panel displays a list of all the available actions. To select information, move the contents of the panel up and down, and display another panel to be used to process selected information. Each action is identified by a number.

To select an action, type its number in the selection field at the bottom of the panel and press Enter. To select an item of information, use the number assigned to it. If information is already selected, type the number assigned to the action you want to perform on it.
Refresh and return

Because the ASCII console is a remote connection, the screen display can sometimes become disarranged. For that reason, the panels include an action called Refresh, which is always action 1. The last action listed on a panel returns you to the previous panel. Return is always action 0.

When an action is unavailable

If an action is not currently available, it is displayed in square brackets.
Appendix B. Changing the appearance of the graphical user interface

This section describes how to use the supplied environment files to change the WebSphere Voice Response graphical user interface to use large fonts and high contrast colors.

Using the graphical user interface with large fonts and high contrast

To use the large font environment files, it is recommended that you have a large display monitor, no smaller than 21 inches and a video card capable of a high resolution to accommodate the large text.

Environment files with the following characteristics are supplied with WebSphere Voice Response:
- Black on White
- White on Black
- Black on Yellow
- Blue on Black
- Gray on Blue (default style of the graphical user interface)

Changing to a different environment

To change the environment file currently in use:
1. Log into the system as dtuser but do not start WebSphere Voice Response.
2. Type the following command:
   
   ```
   export ColorChoice=environment
   ```

   where environment is:
   - BlackOnWhite for the large text, black on white version of the graphical user interface
   - WhiteOnBlack for the large text, white on black version of the graphical user interface
   - YellowOnBlack for the large text, yellow on black version of the graphical user interface
   - Blue for the blue version of the graphical user interface
   - Typing any other word will load the default version of the graphical user interface
3. Close the GUI and type the command \texttt{vaeinit}, followed by Enter for the changes to take effect.
Notices

This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

The IBM Director of Licensing, IBM Corporation,
North Castle Drive,
Armonk,
NY 10504-1785,
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing,
2-31 Roppongi 3-chome Minato-ku,
Tokyo 106,
Japan.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact: IBM UK Limited, Department 88013, 4NW, 76/78 Upper Ground, London, SE1 9PZ, England. Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Programming License Agreement, or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

COPYRIGHT LICENSE: This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly
tested under all conditions. IBM, therefore, cannot guarantee or imply
reliability, serviceability, or function of these programs.

For country-specific notes on the use of WebSphere Voice Response, refer to
the README file located in the directory /usr/lpp/dirTalk/homologation.
The file name is in the format README_homologation.xxxx, where xxxx is
the country/region identifier.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other
countries, or both. If these and other IBM trademarked terms are marked on
their first occurrence in this information with a trademark symbol (® or ™),
these symbols indicate U.S. registered or common law trademarks owned by
IBM at the time this information was published. Such trademarks may also be
registered or common law trademarks in other countries. A current list of IBM
trademarks is available on the Web at [Copyright and trademark information](http://www.ibm.com/legal/copytrade.shtml).

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Other company, product or service names may be trademarks or service
marks of others.
Glossary

The following terms and abbreviations are defined as they are used in the context of WebSphere Voice Response. If you do not find the term or abbreviation you are looking for, see IBM Dictionary of Computing, McGraw-Hill, 1994, or the Glossary.

A

Action  See state table action

Action Palette
   An area containing folders and icons that can be selected to create state table actions.

autostubbing
   A state table icon view utility that automatically converts lines into stubs when they cross a specified number of columns.

C

check box
   A square with associated text that represents a choice. When a user selects the choice, the check box is filled to indicate that the choice is selected.

click
   To press and release a mouse button without moving the mouse.

click...button
   A pushbutton that displays a list of mutually-exclusive choices when selected.

F

folder
   A container used to organize objects, such as voice applications. To display the objects in a folder, the user clicks on the folder icon with mouse button 1.

H

hover help
   Help information displayed when the mouse pointer is positioned over an item.

I

icon
   A graphical representation of an item on the screen.
input field
A rectangular area into which a user types or places text. Many input fields are preceded by a pushbutton that enables users to select the text from a list.

input focus
The position on the screen where an action takes effect. If a field has the input focus, text a user types appears in that field. If an object has the input focus, user actions affect that object.

K
keyword
A descriptive word on a window action bar that defines a menu of actions. Clicking on a keyword reveals the associated menu.

M
maximize
To enlarge a window to its largest possible size.

menu
A list of selectable actions available at different points in the operation of a program.

menu bar
The area at the top of a window that displays keywords that provide access to actions available in the window.

minimize
To reduce a window to its smallest possible size and remove all of the windows associated with that window.

mouse
A navigational device that a user moves on a flat surface to position a pointer on the screen. By pressing buttons on the mouse, users can select actions and perform operations in WebSphere Voice Response windows.

mouse button
A component of a mouse that a user presses to select actions or perform operations.

P
pointer
A graphical symbol displayed on the screen that is controlled by a navigational device, such as a mouse.

push button
A component in a window that allows the user to invoke a specific action.

R
radio button
A diamond with text beside it, indicating one of a number of mutually-exclusive choices. The button is highlighted when it is selected.

S
scroll
To move displayed information horizontally or vertically in a window to view data that extends beyond the borders of the window.

select
To mark or choose an item in a window, action bar, or menu.

Shift-click
To click while holding down the Shift key.

shut down
To stop online operation.

SMIT
See System Management Interface Tool (SMIT)
state  One step in the logical sequence of actions that comprises a WebSphere Voice Response voice application.

state table  A list of all the actions used in a particular voice application. A component of WebSphere Voice Response.

state table action  One instruction in a set of instructions contained in a WebSphere Voice Response state table that controls how WebSphere Voice Response processes various operations such as playing voice prompts or recording voice messages. See also state.

stub  A line in a state table that is only partially displayed.

System Management Interface Tool (SMIT)  A set of utilities that can be used for various purposes, such as loading WebSphere Voice Response software, installing the exchange data link, and defining SNA profiles.

system menu  A menu that appears from the system menu symbol (shaped like a spacebar) in the leftmost part of a title bar. The system menu contains choices that affect the window or the view it contains.

W

window  An area of the screen with defined borders in which information is displayed. A window may be equal in size to the entire screen, or may share the screen with other windows.

work area  A box you can use to edit text. For example, you can use work areas to create and edit prompts.

T

toolbar  An area containing icons that can be selected to perform actions. By default, toolbars appear at the top of a window, under the menu bar.
List of WebSphere Voice Response and associated documentation

Here is a list of the documentation for WebSphere Voice Response for AIX and associated products. PDF and HTML versions of the documentation are available from the IBM Publications Center at http://www.ibm.com/shop/publications/order. Hardcopy books, where available, can be ordered through your IBM representative or at this Web site.

WebSphere Voice Response for AIX documentation can also be found by going to the IBM Pervasive software Web site at http://www.ibm.com/software/pervasive, selecting the WebSphere Voice products link, and then selecting the library link from the WebSphere Voice Response page.

PDF and HTML versions of the WebSphere Voice Response for AIX publications are available on the CD-ROM supplied with the product. In addition, WebSphere Voice Response for AIX, WebSphere Voice Response for Windows, Unified Messaging, and other WebSphere Voice publications are available together in PDF and HTML formats on a separately-orderable CD-ROM (order number SK2T-1787).

Note: To read PDF versions of books you need to have the Adobe Acrobat Reader (it can also be installed as a plug-in to a Web browser). It is available from Adobe Systems at http://www.adobe.com.

WebSphere Voice Response software

- WebSphere Voice Response for AIX: General Information and Planning, GC34-7084
- WebSphere Voice Response for AIX: Installation, GC34-7095
- WebSphere Voice Response for AIX: User Interface Guide, SC34-7091
- WebSphere Voice Response for AIX: Configuring the System, SC34-7078
- WebSphere Voice Response for AIX: Managing and Monitoring the System, SC34-7085
- WebSphere Voice Response for AIX: Designing and Managing State Table Applications, SC34-7081
- WebSphere Voice Response for AIX: Application Development using State Tables, SC34-7076
- WebSphere Voice Response for AIX: Developing Java applications, GC34-7082
- WebSphere Voice Response for AIX: Deploying and Managing VoiceXML and Java Applications, GC34-7080
IBM hardware for use with WebSphere Voice Response

- IBM Quad Digital Trunk Telephony PCI Adapter (DTTA): Installation and User’s Guide, part number 00P3119 (DTTA card)

WebSphere Voice Response related products

WebSphere Voice Server

The documentation for Version 5.1 of WebSphere Voice Server is provided in the form of an HTML-based information center, and can be found at:


Unified Messaging for WebSphere Voice Response

- Unified Messaging: General Information and Planning, GC34-6398
- Unified Messaging: Subscriber’s Guide (Types 0, 1, 2, 3, 4 and 9), SC34-6403
- Unified Messaging: Subscriber’s Guide (Types 5, 6, 7 and 8), SC34-6400
- Unified Messaging: Administrator’s Guide, SC34-6399
- Unified Messaging: Voice Interface, GC34-6401
- Unified Messaging: Web Services Voicemail API, SC34-6975

Unified Messaging publications can be found by going to the IBM Pervasive software Web site at http://www.ibm.com/software/pervasive, selecting the products link, and then selecting the library link from the Unified Messaging page.

AIX and the IBM pSeries computer

For information on AIX Version 6.1, refer to the AIX V6.1 infocenter
For information on System p5 and BladeCenter computers, refer to the IBM Power hardware infocenter.

HACMP

- HACMP for AIX: HACMP 5.4 Concepts and Facilities, SC23-4864-09
- HACMP for AIX: HACMP 5.4 Planning Guide, SC23-4861-09
- HACMP for AIX: HACMP 5.4 Installation Guide, SC23-5209-00
- HACMP for AIX: HACMP 5.4 Administration Guide, SC23-4862-09
- HACMP for AIX: HACMP 5.4 Smart Assist for DB2, SC23-5179-03
- HACMP for AIX: HACMP 5.4 Troubleshooting, SC23-5177-03
- HACMP for AIX: Enhanced Scalability Installation and Administration Guide, Volume 1, SC23-4284

For more information on HACMP, refer to the HACMP Library and the AIX V6.1 infocenter.

SS7


IBM SS7 Support for WebSphere Voice Response observes the applicable parts of the following specifications for ISUP:
- ITU-T (formerly CCITT) Recommendations Q.700 - Q.716, Volume VI Fascicle VI.7
- ITU-T (formerly CCITT) Recommendations Q.721 - Q.725, Volume VI Fascicle VI.8
- ITU-T (formerly CCITT) Recommendations Q.771 - Q.775, Q.791, Volume VI Fascicle VI.9

ADC

Integrated Services Digital Network

WebSphere Voice Response ISDN support observes the applicable parts of the following standards for User Side protocol:

Custom ISDN Standards:

- *Northern Telecom DMS/250 Primary Rate Interface NIS A211-4 Release 8, July 1995.* (IEC05 level)
- *Northern Telecom DMS/100 Primary Rate Interface NIS A211-1 Release 7.05, May 1998.* (NA007 & RLT)
- *AT&T 5ESS Switch. ISDN Primary Rate Interface Specification. 5E7 and 5E8 Software Release AT&T 235-900-332. Issue 2.00 December 1991*
- *AT&T 5ESS Switch. ISDN Primary Rate Interface Specification. 5E9 Software Release AT&T 235-900-342. Issue 1.00 November 1993* (National ISDN only)
- *Lucent 5ESS-2000 Switch ISDN Primary Rate Interface, Interface Specification, 5E9(2) and Later Software Releases, 235-900-342. Issue 5.00 January 1997* (National ISDN only)
- *AT&T ISDN Primary Rate Specification TR41449 July 1989*
- *AT&T ISDN Primary Rate Specification TR41459 August 1996*

Euro-ISDN

The following documents refer to the specifications required for observing ISDN:

- *TBR4-ISDN; Attachment Requirements For Terminal Equipment To Connect To An ISDN Using ISDN Primary Rate Access, Edition 1, Nov. 95, English*
- *CTR 4 - European Communities Commission Decision 94/796/EC published in the Official Journal of the European Communities L 329, 20 December 94 (ISDN PRA)*

National ISDN

National ISDN is described in the following publications:

- *National ISDN, SR-NWT-002006, Issue 1, August 1991, published by Bellcore*
- *National ISDN-2, SR-NWT-002120, Issue 1, May 1992, published by Bellcore*

INS Net Service 1500

INS Net Service is described in the following publications:
• Interface for the INS Net Service Volume 1 (Outline), 7th Edition, published by Nippon Telegraph and Telephone Corporation
• Interface for the INS Net Service Volume 3 (Layer 3 Circuit Switching), 5th Edition, published by Nippon Telegraph and Telephone Corporation

Belcore Specifications for ADSI Telephones

The following Belcore specification documents contain technical details of the requirements for ADSI telephones, and the interface to voice response systems such as WebSphere Voice Response:

• SR-INS-002461: CustomerPremises Equipment Compatibility Considerations for the Analog Display Services Interface
• TR-NWT-001273: Generic Requirements for an SPCS to Customer Premises Equipment Data Interface for Analog Display Services
deselecting
  icons 29
list items 26
details view 41
display name 1, 2
double-click 14
drag and drop, when editing state tables 14
drag and drop, when working with applications 14
drop-down button 21
dtuser account 1
E
editing
text 23
ellipsis 20, 21
exporting
  command-line commands 58
F
field
  See input field 23
file
  searching for 45
File Search window 45
folder
  Action Palette folders 49
general 27
  objects folder 42
  popup menu 49
  fonts, making larger 63
G
graphical view
  See icon view 41
grayed option 20, 21
H
help, online
  displaying 18, 21
  editor 8
    menu option 8
  menu 11
   On help menu option 11
  On window menu option 11
  high contrast, setting 63
hover help
  description 30
  viewing 49
I
icon
  deselecting 29
  general 27
  selecting 28
  view
    Application windows 41
icon (continued)
  view (continued)
    State Table window 48
immediate shutdown 5, 9
importing
  command-line commands 58
input field 23
K
keyboard
  alternatives 20
keyboard shortcuts
    cursor 17
general 15
input focus 16
  lists 16
  menus 17
  system menu 15
  windows 15
L
label
  searching for 25
language
  menu option 8
large fonts, setting 63
list item
  deselecting 26
  searching for 24
  selecting 26
list view
  tasks 54
  using 48
logging off 4
  menu option 7
logging on
  ASCII console 58
  general 1
  menu option 7
  remote terminal 3
M
maximizing a window 18
menu
  bar 18
general 20
keyboard shortcuts 17
  See also popup menu 20
selecting options 20
Welcome window 7, 11
minimizing a window 18
mouse
  actions with 15
  AIX window, switching to 4
  buttons 13
mouse (continued)
  left- and right-handed 13
  moving
    objects 42
    state table actions 50
    states 53
    windows 18

O
  object
    name 28
    popup menu 28
    working with 42

  OK pushbutton 21
  online help
    See help, online 18

opening
  applications 42
  mouse actions 14
  Object Index 46
  objects 19, 28
  state table actions 50
  operations menu 9
  overlaying windows 19

P
  pack configuration
    menu option 7
  popup menu
    Action 49
    Action Palette 49
    Application 28
    displaying 20
    Folder 49
    object 28

prompt
  menu option 10
  pushbutton 21

Q
  quiesce shutdown 5, 10

R
  radio button 21
  renaming
    Action Palette folders 50
    state table actions 50
  resizing windows 18
  restarting
    WebSphere Voice Response 5

searching
  for files 45
  for labels 25
  for list items 24
  for text 25
  for variables 25

selecting
  ASCII console options 60
  check boxes 21
  drop-down buttons 22
  icons 28
  list items 16
  menu options 20
  mouse actions 14
  pushbuttons 21
  radio buttons 22
  setting high contrast 63
  setting large fonts 63
  Shift-click 14
  shutting down 5
    menu options 9

sorting 41
SR-INS-002461 Bellcore specification 77

starting
  WebSphere Voice Response 1

state
  connecting 52, 53
  deleting 54
  general 47
  working with 51
  state table
    connections 52, 53
    creating with ASCII editor 57
    menu option 10
    working with 51

state table actions
  popup menu 49
  renaming 50
  working with 49, 51

State Table window
  Action Palette and folders 47
  actions and states 51, 54
  folders and actions 49, 51

statistics
  menu option 9

subscriber class
  menu option 8

syntax rules
  flags 38
  parameters 39

system configuration option 7

System Configuration windows 54

system folders
  reloading 51
system menu
  keyboard shortcuts 15
  using 18
system monitor
  menu option 9
system parameters
  changing 54, 56
T
text
  editing 17, 23
  searching for 25
text view
  See details view, list view 41
toolbar
  general 30
TR-NWT-001273 Bellcore specification 77
V
vaemnt command 2, 4, 5
variable
  searching for 25
view
  details view 41
  icon view
    customizing your view 41
    using list view 48
  list view 48, 54
  sorting 41
voice application
  creating 42
  menu option 10
  opening 42
  popup menu 28
voice segment
  menu option 10
voice tables
  menu option 10
W
Welcome window
  closing 5, 7
  menus 7, 11
window
  Application window 42
  Applications window 41
  container 19
  Dependencies windows 43
  File Search window 45
  general 18
  State Table window 47, 54
  System Configuration window 54
  work area 23

X
X-Windows
  logging on 1
  xhost command 3
Program Number: 5724-I07